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Documentation Updates
The title page of this document contains the following identifying information:

l Software Version number, which indicates the software version.

l Document Release Date, which changes each time the document is updated.

l Software Release Date, which indicates the release date of this version of the software.

To check for recent updates or to verify that you are using themost recent edition of a document, go
to:

http://h20230.www2.hp.com/selfsolve/manuals

This site requires that you register for an HP Passport and sign in. To register for an HP Passport
ID, go to:

http://h20229.www2.hp.com/passport-registration.html

Or click theNew users - please register link on the HP Passport login page.

You will also receive updated or new editions if you subscribe to the appropriate product support
service. Contact your HP sales representative for details.
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Support
Visit the HP Software Support Online web site at:

http://www.hp.com/go/hpsoftwaresupport

This web site provides contact information and details about the products, services, and support
that HP Software offers.

HP Software online support provides customer self-solve capabilities. It provides a fast and
efficient way to access interactive technical support tools needed tomanage your business. As a
valued support customer, you can benefit by using the support web site to:

l Search for knowledge documents of interest

l Submit and track support cases and enhancement requests

l Download software patches

l Manage support contracts

l Look up HP support contacts

l Review information about available services

l Enter into discussions with other software customers

l Research and register for software training

Most of the support areas require that you register as an HP Passport user and sign in. Many also
require a support contract. To register for an HP Passport ID, go to:

http://h20229.www2.hp.com/passport-registration.html

To findmore information about access levels, go to:

http://h20230.www2.hp.com/new_access_levels.jsp
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Upgrade to Version 9.30 - Overview
This section explains how to upgrade to version 9.30.

Note: The upgrade path that is currently supported is:
9.00 MLU SW Media (full 9.02) => 9.03 => 9.30

If you require other upgrade path, contact HP Software Support Online web site
(http://www.hp.com/go/hpsoftwaresupport).

Important:Connecting the new 9.3 instance to the 9.03 will disable the existing 9.03 instance

Tip: Duplicate the existing 9.03 schemas and connect to the duplicated schemas.

The upgrade procedure is as follows:

1. Perform the relevant upgrade procedure:

n "Upgrade to 9.30 in a Typical Environment" on page 7

n "Upgrade to 9.30 in a Distributed Environment" on page 24

2. Perform the "Run the Post-Upgrade Script" on page 49.
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Upgrade to 9.30 in a Typical Environment
To upgrade to version 9.30 when you had a typical (one server) configuration in 9.03, use the
following procedure:

1. "Prerequisites" below

2. "Backup and Restore DataWarehouse Databases" on next page

3. "Install Version 9.30 on a New Server" on page 9

4. "Configure SAP BusinessObjects Enterprise" on page 16

Prerequisites
1. At the end of the upgrade process you will have to run a post-upgrade script that fixes data

correctness-related issues (For details, see "Run the Post-Upgrade Script" on page 49).
Contact HP Software Support Online web site (http://www.hp.com/go/hpsoftwaresupport) to
obtain the script.

2. It is recommended to duplicate all the 9.03 schemas before starting the upgrade procedure in
order to have both 9.03 and 9.30 up and running after the upgrade. To duplicate a schema in
MSSQL, right-click the schema, select Tasks > Back Up. In the Back UpDatabase <file_
name> dialog box, enter the name of the back up file in theName field in theBackup Set area,
select where you want to save the duplicate in theDestination area, and click OK. Make sure
that the back up is successful.

3. Make sure to back up the database Logins and that each user's status is enabled and not
locked.

4. It is recommended to install the 9.30 version on new hardware in order to have both 9.03 and
9.30 up and running after the upgrade.

5. Youmust backup the 9.03 <HPXS folder>\agora\DataWarehouse\ExternalSources folder
before starting the upgrade of DataWarehouse to a location on the 9.30 server (the path should
be without spaces).

6. To restore theManagement, Result, Target, and Staging databases, right-click Database in
the relevant SQL server and select Restore Database. In the Restore Database dialog box,
select From device, and click the button. In the Specify Backup dialog box, click Add. Select
the duplicate file, and click OK.

7. Install the following on the DataWarehouse server, before you start the DataWarehouse
component installation:
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a. SQLCMD utility as follows:

i. On theMicrosoft SQL Server 2008 Enterprise Edition with SP 2CD, run Setup.

Note:

o If you did not previously install Microsoft .NET Framework 3.5.1 on your
server, youmay be prompted to install it. When installingMicrosoft .NET
Framework 3.5.1, make sure that WCF Activation is unchecked.

o When installing the SQLCMD utility, make sure that the path to the utility is
not enclosed in quotes (") and does not include quotes as this might cause the
installation of DataWarehouse to fail.

ii. Select New SQL Server Standalone Installation.

iii. On the Feature Select screen, selectManagement Tools - Basic, unselect
Management Tools - Complete, and finish theWizard.

Note: If you want to use the default HTTP port in the Executive Scorecard
installation, ensure that port 80 is available after the installation of the SQLCMD
tool. For more information about the ports, see the Support Matrix document
available from the Support Site
(http://h20230.www2.hp.com/selfsolve/manuals or from the Installation DVD).

8. When using M-iCP:
Configure the DataWarehouse server to avoid low virtual memory prompts when usingM-iCP
as follows:

a. Make sure that you have a hard disk capacity of at least 60G-80G.

b. Set the server virtual memory to system managed size.

c. Restart the server.

d. In Folder Options, clearHide protected operating system files.

e. Make sure that the pagefile.sys size is greater or equal to your physical memory size.

f. Make sure that you have enough free space on your system drive.

Backup and Restore Data Warehouse Databases
The DataWarehouse database upgrade process requires you to clone the current production
database into the same instance (on the samemachine) and to implement the upgrade process on
the cloned database.

Before performing backup and restore make sure:

l The database server has enough disk space to contain both the backup files and the cloned
database.

l The directory structure and drives for the cloned database exist on the server.
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l The source database names do not exist in the destination database. If the names do exist, they
will be overwritten.

To backup and restore the Data Warehouse databases:

Note: DataWarehouse only supports Microsoft SQL Server 2008 R2, therefore the backup
and restore process is only supported for this version.

1. Backup the source Staging, Target, Management, and Results databases using SQL Server
2008 Studio. Make sure that the backup file names are unique and that they do not exist on the
destination database server.

Note: Youmust also backup the SAP BusinessObjects Data Services database for
disaster recovery purposes.

2. Restore the backup of each one of the source databases on the destination server using the
new names. For details, see DataWarehouse Recovery in theAdministrator Guide.

3. Replace the string <Staging Schema_Name> with the name of the actual Staging schema and
the string <Target Schema_Name> with the name of the actual Target schema in the <DVD_
ROOT>/Security_Upgrade_Script/Upgrade_9.03-9.3_PreReq_SecurityScript.sql script.

4. Execute the Upgrade_9.03-9.3_PreReq_SecurityScript.sql script on both the Staging and
Target databases.

Install Version 9.30 on a New Server

Note: No data will be lost during the upgrade process. All data that is created during the
upgrade process will be retrieved upon completion directly from the data sources.

1. Ensure that you have the relevant installation settings required for the installation as described
in the Installation Checklists.

2. Close all Windows before you start the installation process.

3. Insert the XS media into the CD/DVD drive. The installation wizard opens.

Caution: The CD/DVD must remain in the drive until you complete the Executive
Scorecard ConfigurationWizard.

Note: If the installation wizard does not start automatically, run the file: <DVD_
ROOT>\Windows_Setup\HPXS_9.30_setup.exe
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 If you copy the installation directory from the DVD or from HPLN, make sure that the
path to the target directory does not include blank spaces.

4. Installation Section of Wizard

Follow the prompts until you get to theSelect Group page.

5. On theSelect Group page, select the type of installation you are performing: Typical, and
then click Next.

6. If necessary, on theSelect Features page, select the component you are installing on this
server, and then click Next.

Common Components are automatically selected and installed with each component.

7. On theChoose the folders page, click Next to accept the default application folder, or
Browse to navigate to and then select a new application folder location.

Note: If you enter a new application folder name, it cannot contain embedded spaces. For
example a folder with a nameHP XS is invalid.

The wizard then runs a series of checks to validate system requirements.

8. On the Install Checks page, ensure that all the installation checks are successful, and then
click Next.

If an installation check failed, youmight be required to perform corrective action before you can
run the installer. Certain checks can be corrected after a component has been installed.

Note: Checks not relevant to this server are passed automatically.

9. On thePre-Install Summary page, verify that the components you wish to install are listed,
and then click Install. The Post-Install wizard window opens.

The file copying process starts. On completion, the ConfigurationWizard begins.

Note: If the server is not compliant with certain minimum system requirements such as
free disk space, the install process does not begin.

Run the Post-Install Wizard

1. On the Introduction page of the ConfigurationWizard, click Next.

2. In theConfiguration Wizard - Introduction page, click Next.

Note: Make sure that in the following steps, you enter the details about the restored
databases.
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3. Configure the Management Database:
a. In theManagement Database - Configure Management Settings page, select Connect

to an existing database and click Next.

UI Element Description

Create a new
database

This option to creates a new Management database.

Select this option when installing the first HP IT Executive Scorecard
component.

Connect to an
existing
database

This option connects to an existingManagement database.

Select this option when theManagement database has already been
created while installing a previous component or when performing an
upgrade.

b. In theManagement Database - Configure Management Database Connectivity
Settings page, enter the relevant information and in theDatabase name field the name of
the duplicated 9.03Management Schema, and click Next.

Enter connectivity and authentication parameters for the MS SQL Server database:

UI
Element Description

Host
name

The fully qualified domain name (FQDN) or IP address of theMS SQLServer
hosting theManagement database.

Note:

o If you work with the Named Instance feature, format Host Name as
follows: <host_name>\<instance_name>.

o The named instance capability is only available for new installations.
Port
<1433>

The port of theMS SQL server listener. The default port is 1433. Change this
value to connect to a non-default database instance on the server.

For more information about ports, see the Support Matrix document available
from the Support Site (http://h20230.www2.hp.com/selfsolve/manuals or
from the Installation DVD).

Note:

o If you work with the Named Instance feature, you can omit the port number
(it is automatically detected during the installation).

o The named instance capability is only available for new installations.
Database
name

The name of theManagement database.

It is recommended that you use the following database naming convention:
databasename_mng_upg

Tip: Make note of the database name, as it may be needed when installing
other components.
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SQL Server authentication:

UI
Element Description

Login
Name

TheMS SQL login name used to create or connect to the database.

The user must have the administrator permissions.
Password The password for the specified user.

Note:

o The following characters: a-z, A-Z, 0-9, _ (underscore) are supported.

o The passwordmust be at least 6 characters in length, andmust contain a
combination of two of the following; upper case, lower case, numbers and
punctuation.

o The password can be changed by the Administrator. In such a case, the
relevant password setting should be changed accordingy.

c. In theManagement Database - Upgrade required page, check thatWould you like to
perform the upgrade? message is displayed, and click Next.

d. In theManagement Database - Configure Result Database Connectivity Settings for
the Upgrade page, enter the relevant information and enter in theDatabase Name field
the name of the duplicated 9.03 Result/DATA Schema, and click Next.

Enter connectivity and authentication parameters for the Result MS SQL Server
database:

UI
Element Description

Host
name

The fully qualified domain name (FQDN) or IP address of theMS SQLServer
hosting the Result database.

Note:

o If you work with the Named Instance feature, format Host Name as
follows: <host_name>\<instance_name>.

o The named instance capability is only available for new installations.
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UI
Element Description

Port
<1433>

The port of theMS SQL server listener. The default port is 1433. Change this
value to connect to a non-default database instance on the server.

For more information about ports, see the Support Matrix document available
from the Support Site (http://h20230.www2.hp.com/selfsolve/manuals or
from the Installation DVD).

Note:

o If you work with the Named Instance feature, you can omit the port number
(it is automatically detected during the installation).

o The named instance capability is only available for new installations.
Database
name

The name of the Result database that was restored earlier.

It is recommended that you use the following database naming convention:
databasename_res_upg

SQL Server authentication:

UI
Element Description

Login
Name

TheMS SQL login name used to create or connect to the database.

The user must have the administrator permissions.
Password The password for the specified user.

Note:

o The following characters: a-z, A-Z, 0-9, _ (underscore) are supported.

o The passwordmust be at least 6 characters in length, andmust contain a
combination of two of the following; upper case, lower case, numbers and
punctuation.

o The password can be changed by the Administrator. In such a case, the
relevant password setting should be changed accordingy.

e. In theManagement Database - Configure Target Database Connectivity Settings for
the Upgrade page,enter the relevant information and enter in theDatabase Name field the
name of the duplicated 9.03 Target Schema, and click Next.

Enter connectivity and authentication parameters for the Target MS SQL Server
database:

UI
Element Description

Host
name

The fully qualified domain name (FQDN) or IP address of theMS SQLServer
hosting the Target database.
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UI
Element Description

Note:

o If you work with the Named Instance feature, format Host Name as
follows: <host_name>\<instance_name>.

o The named instance capability is only available for new installations.
Port
<1433>

The port of theMS SQL server listener. The default port is 1433. Change this
value to connect to a non-default database instance on the server.

For more information about ports, see the Support Matrix document available
from the Support Site (http://h20230.www2.hp.com/selfsolve/manuals or
from the Installation DVD).

Note:

o If you work with the Named Instance feature, you can omit the port number
(it is automatically detected during the installation).

o The named instance capability is only available for new installations.
Database
name

The name of the Target database that was restored earlier.

It is recommended that you use the following database naming convention:
databasename_trg_upg

SQL Server authentication:

UI
Element Description

Login
Name

TheMS SQL login name used to create or connect to the database.

The user must have the administrator permissions.
Password The password for the specified user.

Note:

o The following characters: a-z, A-Z, 0-9, _ (underscore) are supported.

o The passwordmust be at least 6 characters in length, andmust contain a
combination of two of the following; upper case, lower case, numbers and
punctuation.

o The password can be changed by the Administrator. In such a case, the
relevant password setting should be changed accordingy.

f. In theManagement Database - Configure Staging Database Connectivity Settings
for the Upgrade page,enter the relevant information and enter in theDatabase Name field
the name of the duplicated 9.03 Staging Schema, and click Next.

Enter connectivity and authentication parameters for the Staging MS SQL Server
database:
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UI
Element Description

Host
name

The fully qualified domain name (FQDN) or IP address of theMS SQLServer
hosting the Staging database.

Note:

o If you work with the Named Instance feature, format Host Name as
follows: <host_name>\<instance_name>.

o The named instance capability is only available for new installations.
Port The port of theMS SQL server listener. The default port is 1433. Change this

value to connect to a non-default database instance on the server.

For more information about ports, see the Support Matrix document available
from the Support Site (http://h20230.www2.hp.com/selfsolve/manuals or
from the Installation DVD).

Note:

o If you work with the Named Instance feature, you can omit the port number
(it is automatically detected during the installation).

o The named instance capability is only available for new installations.
Database
name

The name of the Staging database that was restored earlier.

It is recommended that you use the following database naming convention:
databasename_stg_upg

SQL Server authentication:

UI
Element Description

Login
Name

TheMS SQL login name used to create or connect to the database.

The user must have the administrator permissions.
Password The password for the specified user.

Note:

o The following characters: a-z, A-Z, 0-9, _ (underscore) are supported.

o The passwordmust be at least 6 characters in length, andmust contain a
combination of two of the following; upper case, lower case, numbers and
punctuation.

o The password can be changed by the Administrator. In such a case, the
relevant password setting should be changed accordingy.

g. In theManagement Database - Upgrade Summary page, check that the upgrade was
completed successfully, and click Next.

h. In theManagement Database - Load a License page, check that a valid permanent
license was found, and click Next.
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UI Element Description

Load a
permanent or
temporary
license

Select to load one of the following license types:

o Permanent - Has no expiry date and is loaded once during the post-
install.

o Temporary - Has an expiry date. On expiration, a new licensemust
be loaded.

To load a license, select Load a permanent or temporary license,
click Load, Navigate to the license file provided by your supplier, and
then click Load License.

Get an
evaluation
license

Select to load a one-off 60 day evaluation license. The remaining valid
period of the license is displayed.

Once the evaluation license terminates, youmust load a temporary or
permanent license.

Configure SAP BusinessObjects Enterprise
1. In theSAP BusinessObjects Enterprise for HP XS - Installation Directory page, enter the

path to the installation directory in the Installation Directory field, and click Next.

UI Element
(A-Z) Description

Installation
directory

The directory where SAP BusinessObjects Enterprise for IT Executive
Scorecard will be installed.

Click Next to install SAP BusinessObjects Enterprise for IT Executive
Scorecard in the default installation directory.

To select an alternate installation directory, click Browse, navigate to the
required installation directory, select it, and proceed with the installation.

2. In theSAP BusinessObjects Enterprise for HP XS - Configure Server Connectivity
page, enter the relevant information, and click Next.

UI Element Description

CMS port The port number of the CMS listener. The default value is 6400. For more
information about ports, see the Support Matrix document available from the
Support Site (http://h20230.www2.hp.com/selfsolve/manuals or from the
Installation DVD).

Administrator
password

The SAP BusinessObjects Enterprise Administrator password.

This password is used only to login to SAP BusinessObjects Enterprise.

Note:

n The following characters: a-z, A-Z, 0-9, _ (underscore) are supported.
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UI Element Description

n The passwordmust be at least 6 characters in length, andmust contain a
combination of two of the following; upper case, lower case, numbers and
punctuation.

n The password can be changed by the Administrator. In such a case, the
relevant password setting should be changed accordingy.

Confirm
administrator
password

Confirm the Administrator password.

Tomcat port The port number of the Tomcat listener. The default value is 8080. For more
information about ports, see the Support Matrix document available from the
Support Site (http://h20230.www2.hp.com/selfsolve/manuals or from the
Installation DVD).

3. In theSAP BusinessObjects Enterprise for HP XS - Configure Central Management
Server (CMS) Database page, select Create a new CMS database, and click Next.

UI Element (A-Z) Description

Create a new CMS
database

Creates a new SAP BusinessObjects Enterprise for IT
Executive Scorecard CMS database.

Connect to an existing
CMS database

Connects to an existing SAP BusinessObjects Enterprise for IT
Executive Scorecard CMS database.

4. In theSAP BusinessObjects Enterprise for HP XS - Configure Central Management
Server (CMS) Database Connectivity Settings page, enter the relevant information and in
theDatabase Name enter the name of the new CMS Schema (9.30), and click Next.

Enter database configuration parameters area:

UI
Element Description

Host
name

The fully qualified domain name (FQDN) or IP address of theMS SQL 2008 Server
hosting the CMS database.

Note:

n If you work with the Named Instance feature, format Host Name as
follows: <host_name>\<instance_name>.

n The named instance capability is only available for new installations.
Port The port of theMS SQL server listener. The default port is 1433. For more

information about ports, see the Support Matrix document available from the
Support Site (http://h20230.www2.hp.com/selfsolve/manuals or from the
Installation DVD).

Note:
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UI
Element Description

n If you work with the Named Instance feature, you can omit the port number (it is
automatically detected during the installation).

n The named instance capability is only available for new installations.
Database
name

The name of the CMS database.

It is recommended that you use the following database naming convention:

databasename_cms

SQL Server authentication area:

UI
Element Description

Login
Name

TheMS SQL login name used to create or connect to the database.

The user must have the administrator permissions.
Password The password for the specified user.

Note:

n The following characters: a-z, A-Z, 0-9, _ (underscore) are supported.

n The passwordmust be at least 6 characters in length, andmust contain a
combination of two of the following; upper case, lower case, numbers and
punctuation.

n The password can be changed by the Administrator. In such a case, the
relevant password setting should be changed accordingy.

5. In theSAP BusinessObjects Enterprise for HP XS - CMS Database Configuration
Status page, make sure that the operation completed successfully, and click Next.

6. In theSAP BusinessObjects Enterprise for HP XS - Configure Audit Database page,
select the Install Audit Schema in the CMS database option, and click Next.

UI Element Description

Install Audit schema in the
CMS database

Installs the Audit database schema as part of the CMS
database previously created.

Create a new Audit database Creates a new Audit database.
Connect to an existing Audit
database

Connect to an existing Audit database.

7. In theSAP BusinessObjects Enterprise for HP XS - Audit Database Configuration
Status page, make sure that the operation completed successfully, and click Next.

8. In theSAP BusinessObjects Enterprise for HP XS - Configuration Status page, make
sure that the operation completed successfully, and click Next.

9. In theApplication Configuration - Configure Web Server Infrastructure Connectivity

HP IT Executive Scorecard (9.30)Page 18 of 50

Upgrade Guide



page, enter the relevant information, and click Next.

Data related configuration area:

UI
Element Description

Time
Zone

The DataWarehouse time zone used when consolidating the data extracted from
the data sources.

This property cannot be changed when upgrading.

Web Server Configuration area:

UI
Element Description

HTTP
port

The port of the HTTP listener. The default port is 80. For more information about
ports, see the Support Matrix document available from the Support Site
(http://h20230.www2.hp.com/selfsolve/manuals or from the Installation DVD).

Note: If you want to use the default HTTP port in the Executive Scorecard
installation, youmust ensure that port 80 is not in use by another process.

HTTPS
port

The port of the HTTPS listener. The default port is 443. For more information about
ports, see the Support Matrix document available from the Support Site
(http://h20230.www2.hp.com/selfsolve/manuals or from the Installation DVD).

Business Objects Enterprise area:

n This area is displayed when installing using a typical configuration.

n This area is not displayed when installing a distributed configuration.

UI Element Description

SSO shared secret Enter the SSO shared secret.

Note: This field is already filled with asterisks (*) when you perform
an upgrade.

Confirm SSO shared
secret

Confirmation of the SSO shared secret.

10. In theApplication Configuration - Configure Infrastructure Connectivity pageenter the
relevant information, and click Next.

UI Element Description

Administrator
user name

The user name for the administrator.

Use this user to log into Executive Scorecard for the first time.

Administrator
password

The password for the administrator.

Note:

n The following characters: a-z, A-Z, 0-9, _ (underscore) are supported.
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UI Element Description

n The passwordmust be at least 6 characters in length, andmust contain
a combination of two of the following; upper case, lower case, numbers
and punctuation.

n The password can be changed by the Administrator. In such a case, the
relevant password setting should be changed accordingy.

Confirm
Administrator
password

Confirmation of the administrator password.

11. In theData Warehouse - SAP BusinessObjects Data Services for HP XS page, enter the
relevant information, and click Next.

Enter database connectivity and authentication details:

UI
Element Description

Host
name

The fully qualified domain name (FQDN) or IP address of theMS SQLServer
hosting the SAP BusinessObjects Data Services for IT Executive Scorecard
database.

n Do not use localhost as the host name.

n The sum of the number of characters of the following names must not exceed
65:
o The Host name FQDN

o The SAP BusinessObjects Data Services for IT Executive Scorecard
database name

o The number of the server port.

o The Login Name.

Note:

n If you work with the Named Instance feature, format Host Name as
follows: <host_name>\<instance_name>.

n The named instance capability is only available for new installations.
Port The port of theMS SQL server listener. The default port is 1433. For more

information about ports, see the Support Matrix document available from the
Support Site (http://h20230.www2.hp.com/selfsolve/manuals or from the
Installation DVD).

Note:

n If you work with the Named Instance feature, you can omit the port number (it is
automatically detected during the installation).
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UI
Element Description

n The named instance capability is only available for new installations.
Database
name

The name of the SAP BusinessObjects Data Services for IT Executive Scorecard
database.

It is recommended that you use the following database naming convention:

databasename_bods

SQL Server authentication area:

UI
Element Description

Login
Name

TheMS SQL login name used to create or connect to the database.

The user must have the administrator permissions.

Password The password of the specified login.

Note:

n The following characters: a-z, A-Z, 0-9, _ (underscore) are supported.

n The passwordmust be at least 6 characters in length, andmust contain a
combination of two of the following; upper case, lower case, numbers and
punctuation.

n The password can be changed by the Administrator. In such a case, the
relevant password setting should be changed accordingy.

Database login authentication area:

UI
Element Description

New
Login
name

A new MS SQL login created for the SAP BusinessObjects Data Services for
IT Executive Scorecard database.

A SAP BusinessObjects Data Services for IT Executive Scorecard database
user account with the same name is automatically created.

Note:

n The Login Name can only comprise alphanumeric characters and if required
an underscore.

n Do not use XS as a new database login name because the XS user name is
already used internally.

Password The password for the new login.

The same password is also applied to the database user account.

HP IT Executive Scorecard (9.30)Page 21 of 50

Upgrade Guide



UI
Element Description

Note:

n The password can comprise alphanumeric characters and an underscore.

n It is important that you save the password in a safe place as it may be
required in certain disaster recovery scenarios.

Confirm
Password

Confirmation of the password for the new login.

Installation directory area:

UI Element Description

Installation
directory

The location where you want to install SAP BusinessObjects Data Services
for IT Executive Scorecard.

Themaximum allowable path length is 69 characters. In addition, the
Installation directory field does not support multi-byte characters. To install
the software on a system with amulti-byte locale, youmust specify the
installation directory with single-byte characters or use the default location.

To run the Designer, a user requires both read and write access to the
installation directory.

12. In theData Warehouse - Currency Configuration page, enter the relevant information, and
click Next.

Currency area:

UI
Element Description

Default
Currency

The currency to use as default. You can select $ as a default.

Tip: If you are using the HP Project and Portfolio Management or the HP Asset
Manager applications as data sources, make sure that you select the currency
corresponding to the currency defined in these applications. For a list of currencies,
see "Supported Currencies".

13. In theData Warehouse - Configure External Source & External Source Active File
Location page, enter the relevant information, and click Next.

UI Element Description

Location The location of the external source files used by DataWarehouse.

The default location is:
<Installationdirectory>\agora\DataWarehouse\ExternalSources

If you are performing an upgrade procedure, the location is where you copied
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UI Element Description

the external sources from the previous version in the prerequisite steps of the
upgrade.

Enable
external
source
archiving

Select to enable archiving external data source data files.

When you select this option, DataWarehouse backs up the flat files created
during the SOURCE EXTRACT phase by the FBI Framework. This backup is
used in case of fault and recovery, to execute the ETLwithout SOURCE
EXTRACT phase, meaning independently on the data source.

Archive
Location

Specify where you want to archive the external data source data files.

Note: Because archiving data files can bememory intensive, it is
recommended to archive to a dedicated separate logical drive.

14. In theData Warehouse - Configuration Status page, make sure that the operation
completed successfully, and click Next.

15. In theExecutive Scorecard - Executive Scorecard Summary page, make sure that the
operation completed successfully, and click Next.

16. In the Financial Planning and Analysis - Installing FPA page, click Next.

17. In the Financial Planning and Analysis - Summary page, make sure that the operation
completed successfully, and click Next.

18. In theSummary page, make sure that the operation completed successfully, and click Finish.

19. Proceed to "Additional Steps" on page 41.
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Upgrade to 9.30 in a Distributed Environment
To upgrade to version 9.30 when you had a distributed configuration in 9.03, use the following
procedure:

1. "Prerequisites" below

2. "Backup and Restore DataWarehouse Databases" on next page

3. "Install BusinessObjects Enterprise" on page 26

4. "Install DataWarehouse on a Separate Server" on page 28

5. "Install Executive Scorecard on a Separate Server" on page 37

Prerequisites
1. At the end of the upgrade process you will have to run a post-upgrade script that fixes data

correctness-related issues (For details, see "Run the Post-Upgrade Script" on page 49).
Contact HP Software Support Online web site (http://www.hp.com/go/hpsoftwaresupport) to
obtain the script.

2. It is recommended to duplicate all the 9.03 schemas before starting the upgrade procedure in
order to have both 9.03 and 9.30 up and running after the upgrade. To duplicate a schema in
MSSQL, right-click the schema, select Tasks > Back Up. In the Back UpDatabase <file_
name> dialog box, enter the name of the back up file in theName field in theBackup Set area,
select where you want to save the duplicate in theDestination area, and click OK. Make sure
that the back up is successful.

3. Make sure to back up the database Logins and that each user's status is enabled and not
locked.

4. It is recommended to install the 9.30 version on new hardware in order to have both 9.03 and
9.30 up and running after the upgrade.

5. It is recommended to backup the 9.03 <HPXS
folder>\agora\DataWarehouse\ExternalSources folder before starting the upgrade of Data
Warehouse to a location on the 9.30 server (the path should be without spaces).

6. To restore theManagement, Result, Target, and Staging databases, right-click Database in
the relevant SQL server and select Restore Database. In the Restore Database dialog box,
select From device, and click the button. In the Specify Backup dialog box, click Add. Select
the duplicate file, and click OK.

7. Install the following on the DataWarehouse server, before you start the DataWarehouse
component installation:
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a. SQLCMD utility as follows:

i. On theMicrosoft SQL Server 2008 Enterprise Edition with SP 2CD, run Setup.

Note:

o If you did not previously install Microsoft .NET Framework 3.5.1 on your
server, youmay be prompted to install it. When installingMicrosoft .NET
Framework 3.5.1, make sure that WCF Activation is unchecked.

o When installing the SQLCMD utility, make sure that the path to the utility is
not enclosed in quotes (") and does not include quotes as this might cause the
installation of DataWarehouse to fail.

ii. Select New SQL Server Standalone Installation.

iii. On the Feature Select screen, selectManagement Tools - Basic, unselect
Management Tools - Complete, and finish theWizard.

Note: If you want to use the default HTTP port in the Executive Scorecard
installation, ensure that port 80 is available after the installation of the SQLCMD
tool. For more information about the ports, see the Support Matrix document
available from the Support Site
(http://h20230.www2.hp.com/selfsolve/manuals or from the Installation DVD).

8. When using M-iCP:
Configure the DataWarehouse server to avoid low virtual memory prompts when usingM-iCP
as follows:

a. Make sure that you have a hard disk capacity of at least 60G-80G.

b. Set the server virtual memory to system managed size.

c. Restart the server.

d. In Folder Options, clearHide protected operating system files.

e. Make sure that the pagefile.sys size is greater or equal to your physical memory size.

f. Make sure that you have enough free space on your system drive.

Backup and Restore Data Warehouse Databases
The DataWarehouse database upgrade process requires you to clone the current production
database into the same instance (on the samemachine) and to implement the upgrade process on
the cloned database.

Before performing backup and restore make sure:

l The database server has enough disk space to contain both the backup files and the cloned
database.

l The directory structure and drives for the cloned database exist on the server.

HP IT Executive Scorecard (9.30)Page 25 of 50

Upgrade Guide

http://h20230.www2.hp.com/selfsolve/manuals
http://h20230.www2.hp.com/selfsolve/manuals


l The source database names do not exist in the destination database. If the names do exist, they
will be overwritten.

To backup and restore the Data Warehouse databases:

Note: DataWarehouse only supports Microsoft SQL Server 2008 R2, therefore the backup
and restore process is only supported for this version.

1. Backup the source Staging, Target, Management, and Results databases using SQL Server
2008 Studio. Make sure that the backup file names are unique and that they do not exist on the
destination database server.

Note: Youmust also backup the SAP BusinessObjects Data Services database for
disaster recovery purposes.

2. Restore the backup of each one of the source databases on the destination server using the
new names. For details, see DataWarehouse Recovery in theAdministrator Guide.

3. Replace the string <Staging Schema_Name> with the name of the actual Staging schema and
the string <Target Schema_Name> with the name of the actual Target schema in the <DVD_
ROOT>/Security_Upgrade_Script/Upgrade_9.03-9.3_PreReq_SecurityScript.sql script.

4. Execute the Upgrade_9.03-9.3_PreReq_SecurityScript.sql script on both the Staging and
Target databases.

Install BusinessObjects Enterprise
SAP BusinessObjects Enterprise for IT Executive Scorecardmust be the first component you
install.

Note: Virus scanning softwaremay interfere with the installation of SAP BusinessObjects
Enterprise for IT Executive Scorecard. Turn off all virus scanning software before installing.

1. Create a Schema in the DB server.

2. In the DB server, if you use a 64 bit operating system, run the command:
C:\Windows\SysWOW64\odbcad32.exe and do not use the option: go to Control Panel >
Administrative Tools > Data Sources (ODBC). You can use this option on 64 bit OS.

3. In theODBC Data Source Administrator, click theSystem DNS tab, and theAdd button to
add related Data Source:

4. In theCreate New Data Source page that opens, select the SQL Server driver and click
Finish.

5. In theCreate a New Data Source to SQL Server page, enter the information to create the
ODBC data source for your BOE database, and click Next.

6. In the next Create a New Data Source to SQL Server page, select the With SQL Server
authentication using a login ID and password entered by the user, select theConnect
to SQL Server to obtain default settings for the additional configuration options and
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enter the Login ID andPassword, Use ANSI quoted identifiers and Use ANSI nulls,
paddings and warnings. Click Next.

7. In the next Create a New Data Source to SQL Server page, select the Schema you created
before and select theChange the default database to option, and select the schema you
created previously. Click Next.

8. In theMicrosoft SQL Server DSN Configuration page, select Perform translation for
character data, and click Finish.

9. In theODBC Microsoft SQL Server Setup page click Test Data Source, and wait for the
message TESTS COMPLETED SUCCESSFULLY!

Install BusinessObjects Enterprise:
1. Close all Windows before you start the installation process.

2. Insert the XS media into the CD/DVD drive. The installation wizard opens.

Caution: The CD/DVD must remain in the drive until you complete the Executive
Scorecard ConfigurationWizard.

Note: If the installation wizard does not start automatically, run the file: <DVD_
ROOT>\Windows_Setup\packages\boe_installer\setup.exe 

 If you copy the installation directory from the DVD or from HPLN, make sure that the
path to the target directory does not include blank spaces.

3. In theBusinessObjects Enterprise XI 3.1 Setup - User Information page, insert the
license key in theProduct Keycode field. Click Next.

4. In theBusinessObjects Enterprise XI 3.1 Setup - Install Type page, select New, Use an
existing database server, andEnable servers upon installation. Click Next.

5. In theBusinessObjects Enterprise XI 3.1 Setup - Server Components Configuration
page, enter 6400 in theCMS port field and select Configure the BusinessObjects
Enterprise Administrator at a later time. Click Next.

6. In theBusinessObjects Enterprise XI 3.1 Setup - Server Intelligence Agent page, enter
the name of the node in theNode Name field, and the port number (6410) in thePort field.
Click Next.

7. In theBusinessObjects Enterprise XI 3.1 Setup - CMS Database Information page, select
SQL Server (ODBC) in theCMS Database area in theSelect existing CMS database
dropdown.

8. Click Browse to select the relevant data source in theData Source Name field and enter the
password in thePassword field, in the SQL Server Logon dialog box. Click OK.

9. In theBusinessObjects Enterprise XI 3.1 Setup page - Select Web Application Server,
select Java Web Application Server and Install Tomcat application server and deploy to
it. Click Next.
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10. Click Next using all the default ports.

Note: TheBOWInstall_0.log Installation log file is saved in the temp folder.

11. To login to BusinessObjects Enterprise after installation, use the following URL:

http://<server name>:8080/CmcApp

User: administrator, Password: (empty).

12. In theBusinessObjects Enterprise XI 3.1 Setup - Automatically Re-Deploy Web
Applications? page, select Yes, automatically re-deploy the web applications. Click
Next.

13. As you have already installed Tomcat, in theBusinessObjects Enterprise XI 3.1 Setup -
Configure Web Application Server page, enter the server instance in theServer Instance
field, the service name in theService Name field, and the path to the Tomcat in the Application
Server Installation Directory field. Click Next to install.

Configure the JDBC driver:
1. Copy the sqljdbc.jar into <BOE install folder>\common\4.0\java\lib\external directory.

2. In the <BOE install folder>\BusinessObjects Enterprise 12.0\win32_
x86\dataAccess\connectionServer\jdbc\jdbc.sbo file add the following lines to the
<JDBCDriver> section of MS SQLServer 2005 configuration:

<ClassPath>

<Path>C:\Program Files (x86)\Business

Objects\common\4.0\java\lib\external\sqljdbc.jar</Path>

</ClassPath>

3. In the <BOE install folder>\common\4.0\java\CRConfig.xml file, add the following in the
<Classpath> section of <DataDriverCommon>:

<BOE install folder>\common\4.0\java\lib\external\sqljdbc.jar;

Install Data Warehouse on a Separate Server
16.

Note: No data will be lost during the upgrade process. All data that is created during the
upgrade process will be retrieved upon completion directly from the data sources.

1. Ensure that you have the relevant installation settings required for the installation as described
in the "Installation Checklists".

2. Close all Windows before you start the installation process.

3. Insert the XS media into the CD/DVD drive. The installation wizard opens.

Caution: The CD/DVD must remain in the drive until you complete the Executive
Scorecard ConfigurationWizard.
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Note: If the installation wizard does not start automatically, run the file: <DVD_
ROOT>\Windows_Setup\HPXS_9.30_setup.exe

 If you copy the installation directory from the DVD or from HPLN, make sure that the
path to the target directory does not include blank spaces.

4. Installation Section of Wizard

Follow the prompts until you get to theSelect Group page.

5. On theSelect Group page, select the type of installation you are performing: Distributed, and
then click Next.

6. If necessary, on theSelect Features page, select the component you are installing on this
server, and then click Next.

Common Components are automatically selected and installed with each component. In
addition, select DataWarehouse and SAP BusinessObjects Enterprise.

7. On theChoose the folders page, click Next to accept the default application folder, or
Browse to navigate to and then select a new application folder location.

Note: If you enter a new application folder name, it cannot contain embedded spaces. For
example a folder with a nameHP XS is invalid.

The wizard then runs a series of checks to validate system requirements.

8. On the Install Checks page, ensure that all the installation checks are successful, and then
click Next.

If an installation check failed, youmight be required to perform corrective action before you can
run the installer. Certain checks can be corrected after a component has been installed.

Note: Checks not relevant to this server are passed automatically.

9. On thePre-Install Summary page, verify that the components you wish to install are listed,
and then click Install. The Post-Install wizard window opens.

The file copying process starts. On completion, the ConfigurationWizard begins.

Note: If the server is not compliant with certain minimum system requirements such as
free disk space, the install process does not begin.

10. In thePost-Install:

a. On the Introduction page of the ConfigurationWizard, click Next.

b. In theConfiguration Wizard - Introduction page, click Next.
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c. Configure the Management Database:
i. In theManagement Database - Configure Management Settings page, select

Connect to an existing database and click Next.

ii. In theManagement Database - Configure Management Database Connectivity
Settings page,enter the relevant information and enter in theDatabase Name field
the name of the duplicated 9.03Management Schema, and click Next.

Enter connectivity and authentication parameters for the MS SQL Server
database:

UI
Element Description

Host
name

The fully qualified domain name (FQDN) or IP address of theMS SQL
Server hosting theManagement database.

Note:

o If you work with the Named Instance feature, format Host Name as
follows: <host_name>\<instance_name>.

o The named instance capability is only available for new installations.
Port
<1433>

The port of theMS SQL server listener. The default port is 1433. Change
this value to connect to a non-default database instance on the server.

For more information about ports, see the Support Matrix document
available from the Support Site
(http://h20230.www2.hp.com/selfsolve/manuals or from the
Installation DVD).

Note:

o If you work with the Named Instance feature, you can omit the port
number (it is automatically detected during the installation).

o The named instance capability is only available for new installations.
Database
name

The name of theManagement database.

It is recommended that you use the following database naming
convention:
databasename_mng_upg

Tip: Make note of the database name, as it may be needed when
installing other components.

SQL Server authentication:

UI
Element Description

Login
Name

TheMS SQL login name used to create or connect to the database.

The user must have the administrator permissions.
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UI
Element Description

Password The password for the specified user.

Note:

o The following characters: a-z, A-Z, 0-9, _ (underscore) are supported.

o The passwordmust be at least 6 characters in length, andmust
contain a combination of two of the following; upper case, lower case,
numbers and punctuation.

o The password can be changed by the Administrator. In such a case,
the relevant password setting should be changed accordingy.

iii. In theManagement Database - Upgrade required page, check thatWould you
like to perform the upgrade? message is displayed, and click Next.

iv. In theManagement Database - Configure Result Database Connectivity
Settings page, enter the relevant information and enter in theDatabase Name field
the name of the duplicated 9.03 Result/DATA Schema, and click Next.

Enter connectivity and authentication parameters for the Result MS SQL
Server database:

UI
Element Description

Host
name

The fully qualified domain name (FQDN) or IP address of theMS SQL
Server hosting the Result database.

Note:

o If you work with the Named Instance feature, format Host Name as
follows: <host_name>\<instance_name>.

o The named instance capability is only available for new installations.
Port
<1433>

The port of theMS SQL server listener. The default port is 1433. Change
this value to connect to a non-default database instance on the server.

For more information about ports, see the Support Matrix document
available from the Support Site
(http://h20230.www2.hp.com/selfsolve/manuals or from the
Installation DVD).

Note:

o If you work with the Named Instance feature, you can omit the port
number (it is automatically detected during the installation).

o The named instance capability is only available for new installations.
Database
name

The name of the Result database that was restored earlier.
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UI
Element Description

It is recommended that you use the following database naming
convention:
databasename_res_upg

SQL Server authentication:

UI
Element Description

Login
Name

TheMS SQL login name used to create or connect to the database.

The user must have the administrator permissions.
Password The password for the specified user.

Note:

o The following characters: a-z, A-Z, 0-9, _ (underscore) are supported.

o The passwordmust be at least 6 characters in length, andmust
contain a combination of two of the following; upper case, lower case,
numbers and punctuation.

o The password can be changed by the Administrator. In such a case,
the relevant password setting should be changed accordingy.

v. In theManagement Database - Configure Target Database Connectivity
Settings for the Upgrade page, enter the relevant information and enter in the
Database Name field the name of the duplicated 9.03 Target Schema, and click
Next.

Enter connectivity and authentication parameters for the Target MS SQL
Server database:

UI
Element Description

Host
name

The fully qualified domain name (FQDN) or IP address of theMS SQL
Server hosting the Target database.

Note:

o If you work with the Named Instance feature, format Host Name as
follows: <host_name>\<instance_name>.

o The named instance capability is only available for new installations.
Port
<1433>

The port of theMS SQL server listener. The default port is 1433. Change
this value to connect to a non-default database instance on the server.

For more information about ports, see the Support Matrix document
available from the Support Site
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UI
Element Description

(http://h20230.www2.hp.com/selfsolve/manuals or from the
Installation DVD).

Note:

o If you work with the Named Instance feature, you can omit the port
number (it is automatically detected during the installation).

o The named instance capability is only available for new installations.
Database
name

The name of the Target database that was restored earlier.

It is recommended that you use the following database naming
convention:
databasename_trg_upg

SQL Server authentication:

UI
Element Description

Login
Name

TheMS SQL login name used to create or connect to the database.

The user must have the administrator permissions.
Password The password for the specified user.

Note:

o The following characters: a-z, A-Z, 0-9, _ (underscore) are supported.

o The passwordmust be at least 6 characters in length, andmust
contain a combination of two of the following; upper case, lower case,
numbers and punctuation.

o The password can be changed by the Administrator. In such a case,
the relevant password setting should be changed accordingy.

vi. In theManagement Database - Configure Staging Database Connectivity
Settings for the Upgrade page,enter the relevant information and enter in the
Database Name field the name of the duplicated 9.03 Staging Schema, and click
Next.

Enter connectivity and authentication parameters for the Staging MS SQL
Server database:

UI
Element Description

Host
name

The fully qualified domain name (FQDN) or IP address of theMS SQL
Server hosting the Staging database.

Note:
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UI
Element Description

o If you work with the Named Instance feature, format Host Name as
follows: <host_name>\<instance_name>.

o The named instance capability is only available for new installations.
Port The port of theMS SQL server listener. The default port is 1433. Change

this value to connect to a non-default database instance on the server.

For more information about ports, see the Support Matrix document
available from the Support Site
(http://h20230.www2.hp.com/selfsolve/manuals or from the
Installation DVD).

Note:

o If you work with the Named Instance feature, you can omit the port
number (it is automatically detected during the installation).

o The named instance capability is only available for new installations.
Database
name

The name of the Staging database that was restored earlier.

It is recommended that you use the following database naming
convention:
databasename_stg_upg

SQL Server authentication:

UI
Element Description

Login
Name

TheMS SQL login name used to create or connect to the database.

The user must have the administrator permissions.
Password The password for the specified user.

Note:

o The following characters: a-z, A-Z, 0-9, _ (underscore) are supported.

o The passwordmust be at least 6 characters in length, andmust
contain a combination of two of the following; upper case, lower case,
numbers and punctuation.

o The password can be changed by the Administrator. In such a case,
the relevant password setting should be changed accordingy.

vii. In theManagement Database - Upgrade Summary page, check that the upgrade
was completed successfully, and click Next.

viii. In theManagement Database - Load a License page, check that a valid permanent
license was found, and click Next.

d. On theApplication Configuration - Configure Infrastructure Connectivity page, enter
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the information and click Next.

Enter connectivity and authentication parameters area:

UI Element Description

Administrator
user name

The user name for the administrator.

Use this user to log into Executive Scorecard for the first time.

Administrator
password

The password for the administrator.

Note:

o The following characters: a-z, A-Z, 0-9, _ (underscore) are
supported.

o The passwordmust be at least 6 characters in length, andmust
contain a combination of two of the following; upper case, lower
case, numbers and punctuation.

o The password can be changed by the Administrator. In such a case,
the relevant password setting should be changed accordingy.

Confirm
Administrator
password

Confirmation of the administrator password.

e. In theApplication Configuration - Configure Infrastructure Connectivity page, enter
the relevant information, and click Next.

UI Element Description

Host name The fully qualified domain name (FQDN) or IP address of the SAP
BusinessObjects Enterprise XI 3.1 server.

CMS Port The port number used by the CMS listener. The default value when
SAP BusinessObjects Enterprise for IT Executive Scorecard is
installed as part of the Executive Scorecard installation, is 6400.

Administrator
User name

The SAP BusinessObjects Enterprise XI 3.1 administrator user name.

Note: This user name and the following password are used when
logging in to the SAP BusinessObjects Enterprise applications.

Administrator
password

The SAP BusinessObjects Enterprise XI 3.1 administrator password.

Confirm
Administrator
password

Confirmation of the administrator password.

SSO shared
secret

The shared secret that is used to authenticate communications with
the SAP BusinessObjects Enterprise XI 3.1 server. If trusted
authentication is configured, the shared secret entered is validated
against the SAP BusinessObjects Enterprise XI 3.1 server. If trusted
authentication is not configured, the entered shared secret is
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UI Element Description

configured on the SAP BusinessObjects Enterprise XI 3.1 server.
Confirm SSO
shared secret

Confirmation of the SSO shared secret.

Authentication
scheme

Select one of the following SAP BusinessObjects Enterprise XI 3.1
authentication schemes that contains the administrator account:

o secEnterprise - When the SAP BusinessObjects administrator
account is a native Enterprise account.

o secLDAP - When the SAP BusinessObjects administrator account
originates from an LDAP user database.

Tomcat Port The port used by the Tomcat listener. The default value is 8080. For
more information about ports, see the Support Matrix document
available from the Support Site
(http://h20230.www2.hp.com/selfsolve/manuals or from the
Installation DVD).

Skip SAP
BusinessObjects
Enterprise
connectivity
configuration

Skip the configuration.

f. Configure and upgrade Data Warehouse:
i. On theData Warehouse - Currency Configuration page, enter the information and

click Next.

Currency area:

UI
Element Description

Default
Currency

The currency to use as default. You can select $ as a default.

Tip: If you are using the HP Project and Portfolio Management or the
HP Asset Manager applications as data sources, make sure that you
select the currency corresponding to the currency defined in these
applications. For a list of currencies, see "Supported Currencies".

ii. On theData Warehouse - Configure External Source & External Source
Archive File Location page, enter the information and click Next.

UI Element Description

Location The location of the external source files used by DataWarehouse.

The default location is:
<Installationdirectory>\agora\DataWarehouse\ExternalSources

If you are performing an upgrade procedure, the location is where you
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UI Element Description

copied the external sources from the previous version in the
prerequisite steps of the upgrade.

Enable
external
source
archiving

Select to enable archiving external data source data files.

When you select this option, DataWarehouse backs up the flat files
created during the SOURCE EXTRACT phase by the FBI
Framework. This backup is used in case of fault and recovery, to
execute the ETLwithout SOURCE EXTRACT phase, meaning
independently on the data source.

Archive
Location

Specify where you want to archive the external data source data
files.

Note: Because archiving data files can bememory intensive, it is
recommended to archive to a dedicated separate logical drive.

iii. On theData Warehouse - Configuration Status Location page, check the
configuration, check that the operation completed successfully, and click Next.

UI Element Description

Location The location of the external source files used by DataWarehouse.

The default location is:
<Installationdirectory>\agora\DataWarehouse\ExternalSources

If you are performing an upgrade procedure, the location is where you
copied the external sources from the previous version in the
prerequisite steps of the upgrade.

Enable
external
source
archiving

Select to enable archiving external data source data files.

When you select this option, DataWarehouse backs up the flat files
created during the SOURCE EXTRACT phase by the FBI
Framework. This backup is used in case of fault and recovery, to
execute the ETLwithout SOURCE EXTRACT phase, meaning
independently on the data source.

Archive
Location

Specify where you want to archive the external data source data
files.

Note: Because archiving data files can bememory intensive, it is
recommended to archive to a dedicated separate logical drive.

Install Executive Scorecard on a Separate Server

Note: No data will be lost during the upgrade process. All data that is created during the
upgrade process will be retrieved upon completion directly from the data sources.
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1. Ensure that you have the relevant installation settings required for the installation as described
in the "Installation Checklists".

2. Close all Windows before you start the installation process.

3. Insert the XS media into the CD/DVD drive. The installation wizard opens.

Caution: The CD/DVD must remain in the drive until you complete the Executive
Scorecard ConfigurationWizard.

Note: If the installation wizard does not start automatically, run the file: <DVD_
ROOT>\Windows_Setup\HPXS_9.30_setup.exe

 If you copy the installation directory from the DVD or from HPLN, make sure that the
path to the target directory does not include blank spaces.

4. Installation Section of Wizard

Follow the prompts until you get to theSelect Group page.

5. On theSelect Group page, select the type of installation you are performing: Distributed, and
then click Next.

6. If necessary, on theSelect Features page, select the component you are installing on this
server, and then click Next.

Common Components are automatically selected and installed with each component. In
addition, select Executive Scorecard.

7. On theChoose the folders page, click Next to accept the default application folder, or
Browse to navigate to and then select a new application folder location.

Note: If you enter a new application folder name, it cannot contain embedded spaces. For
example a folder with a nameHP XS is invalid.

The wizard then runs a series of checks to validate system requirements.

8. On the Install Checks page, ensure that all the installation checks are successful, and then
click Next.

If an installation check failed, youmight be required to perform corrective action before you can
run the installer. Certain checks can be corrected after a component has been installed.

Note: Checks not relevant to this server are passed automatically.

9. On thePre-Install Summary page, verify that the components you wish to install are listed,
and then click Install.

The file copying process starts. On completion, the ConfigurationWizard begins.
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Note: If the server is not compliant with certain minimum system requirements such as
free disk space, the install process does not begin.

10. On the Introduction page of the ConfigurationWizard, click Next.

Post-Install Wizard

Note: Make sure that you installed DWH and BOE on a another server before you installed
XS on this server.

1. In theManagement Database - Management Database Configuration Status page, check
that the operation completed successfully and click Next.

2. On the License Management - Load a License page, verify a permanent license was found
and click Next.

3. Configure and upgrade the Application:
a. On theApplication Configuration - Configure Web Server Infrastructure

Connectivity page, enter the information and click Next.

Data related configuration area:

UI
Element Description

Time
Zone

The DataWarehouse time zone used when consolidating the data extracted
from the data sources.

This property cannot be changed when upgrading.

Web Server Configuration area:

UI
Element Description

HTTP
port

The port of the HTTP listener. The default port is 80. For more information
about ports, see the Support Matrix document available from the Support Site
(http://h20230.www2.hp.com/selfsolve/manuals or from the Installation
DVD).

Note: If you want to use the default HTTP port in the Executive Scorecard
installation, youmust ensure that port 80 is not in use by another process.

HTTPS
port

The port of the HTTPS listener. The default port is 443. For more information
about ports, see the Support Matrix document available from the Support Site
(http://h20230.www2.hp.com/selfsolve/manuals or from the Installation
DVD).

Business Objects Enterprise area:

o This area is displayed when installing using a typical configuration.

o This area is not displayed when installing a distributed configuration.
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UI Element Description

SSO shared secret Enter the SSO shared secret.

Note: This field is already filled with asterisks (*) when you
perform an upgrade.

Confirm SSO shared
secret

Confirmation of the SSO shared secret.

b. On theApplication Configuration - Configure Target Database Settings page, select
the relevant option and click Next.

Select if you want to create a new target database or if you want to connect to an existing
target database:

UI Element Description

Create a new database Select to create a new target database.
Connect to an existing database Select to connect to an existing target database.

4. On theExecutive Scorecard - Executive Scorecard Summary page, check that the
operation completed successfully and click Next.

5. Configure and upgrade Financial Planning and Analysis:
a. On the Financial Planning and Analysis - Installing FPA page, click Next to install the

Financial Planning and Analysis module.

b. On the Financial Planning and Analysis - Summary page, check that the operation
completed successfully and click Next.

6. On theSummary page, check that the operation completed successfully and click Next.

7. Proceed to "Additional Steps" on page 41.
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Additional Steps
Continue with the upgrade with the following steps:

"In case of disaster recovery, restore the SAP BusinessObjects Data Services Database" below

"Reactivate the Data Sources" below

"Move SAP BusinessObjects Enterprise Information" on next page

"Restart Executive Scorecard" on page 46

"Optional, WhenWorkingWith a Non-English Language" on page 46

"Run the Post-Upgrade Script" on page 49

"Regenerate the Staging Target Data Store" on page 49

In case of disaster recovery, restore the
SAP BusinessObjects Data Services Database

In case of disaster recovery, restore the repository to the original data contained in it using the
SAP BusinessObjects Data Service database you backed up before running the upgrade
procedure. For details, see "Restore the BODS Repository" on page 1 in the IT Executive
Scorecard Release Notes.

You do not need to restore the SAP BusinessObjects Data Service database if the upgrade process
was successful.

Reactivate the Data Sources
1. If needed, reconnect to AM, PPM, SM Data SourcesAfter the installation process, if you

use AM, PPM, or SM data sources, youmust, using the Executive Scorecard user interface,
edit the settings of the data sources you want to reactivate as some of the details must be
updated, then you can reactivate the data sources.For more information, see "Integrate the
Data Sources" on page 1 in theContent ReferenceGuide.

2. If the UCMDB Content Pack was activated in 9.03After the installation process, if you use
the UCMDB data source, youmust, using the Executive Scorecard Data SourceManagement
user interface, in the UCMDB data source settings, make sure to remove the extra "00" after
the port number you configured in thePort field..For more information, see "Integrate the Data
Sources" on page 1 in theContent ReferenceGuide.

3. If the NNM Content Pack was activated in 9.03. If the NNMContent Pack was activated in
9.03, and if HP Network NodeManager does not need a password to connect to the shared
folder (for example when the shared folder resides on the local machine), youmust edit the
setting of the connection and delete the password value, before you activate the NNMContent
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Pack. To do that proceed as follows:

a. In the application, click Admin > Data Source Management.

b. Click theEdit Settings link for HP Network NodeManager.

c. Delete the values in thePassword field, and perform any additional changes.

d. Click Next twice.

e. After the data source is successfully configured, click Close.

4. Reactivate the data sources. After completing the upgrade, all connected data sources will
be in theDeactivated state. Youmust reactivate the desired data sources using the Executive
Scorecard user interface. For more information, see "Perform Tasks for Data Source
Management" on page 1 in theAdministrator Guide.

Move SAP BusinessObjects Enterprise Information
To transfer your SAP BusinessObjects Enterprise information

1. Open the Import Wizard in BusinessObjects 3.1, and click Next.

2. On the Source environment screen, in the Source field, chooseBusinessObjects Enterprise
XI 3.x, enter the required information, and click Next.

3. On the Destination environment screen, in the Destination field, chooseBusinessObjects
Enterprise XI 3.x, enter the required information, and click Next.
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4. On the Select objects to import screen, click Clear All, then select Import folders and
objects, Import discussions associated with the selected reports, Import application
folders and objects, Import universes, and then click Next.
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5. Continue to click Next until you reach the Folders and objects screen. Select the relevant
folders and objects and click Next.

6. Continue to click Next until you reach the Import options for universes and connections screen.
Select Import the universes and connections that the selected Web Intelligence and
Desktop Intelligence documents use directly and click Next.
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7. On the Universe folder and universes screen, check the relevant universes and click Next. The
universes that are related to objects that were selected earlier are automatically selected.
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8. Continue to click Next until you reach the Ready to import screen. Review the contents of the
import and click Next. The import process runs.

9. When the import completes, click Done to exit, or click View detail log to see information
about which objects were not transferred.

Restart Executive Scorecard
After you restart the server on which Executive Scorecard is located, the backed up KPIs and
pages that were prepared in the 9.03 system are displayed in the application and you can now use
the Executive Scorecard application.

Optional, When Working With a Non-English
Language

If you are working with a non-English language proceed as follows:

1. Localize the KPI Library
The localized installation adds the language libraries of XML files in specific folders. You copy
and then import these files to display the out-of-the-box template Scorecards, Perspectives,
Objectives, Folders, and KPIs in the KPI Library in the selected language.

To localize the out-of-the box content of the KPI Library: Scorecards, Perspectives,
Objectives, and KPIs, proceed as follows:

a. In the Executive Scorecard server, locate the
<XS_installation_directory>\agora\glassfish\glassfish\domains\BTOA\config\
kpitemplates\import\languages\<language_code>_<country_code> folder relevant for
the language you want to use in the application. The .xml files in the folder represent both
KPIs and KPI directories.

The language code and country codes are as follows:

Language Language Code Country Code

Brazilian Portuguese pt BR

French fr FR

Spanish es ES

German de DE

Japanese ja JP

English en US

Dutch nl NL

Italian it IT
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Language Language Code Country Code

Simplified Chinese zh CN

Korean ko KR

Russian ru RU

b. Copy these .xml files to the <XS_
server>\agora\glassfish\glassfish\domains\BTOA\config\kpitemplates\import\load
folder.

Tip:

If the folder contains other sets of files (for different languages), it is recommended to
keep in the folder only the required set of language files and tomove the other files
outside the folder to prevent the loading of both set of language files and an unknown
result.

c. Import the out-of-the-box language files using theKPILoader > importKPIs() procedure
described in "Import or Export Trees and KPIs"in theAdministrator Guide.

2. Localize the Dashboard Pages and Components
The localized installation adds the language libraries of XML files in specific folders. You copy
and then import these files to display the out-of-the-box template pages and components in the
selected language, in the Dashboard.

To localize the out-of-the box pages and components, proceed as follows:

a. In the Executive Scorecard server, locate the
<XS_installation_
directory>\agora\glassfish\glassfish\domains\BTOA\config\uimashup\
import\languages\Components\<lang>_<country_code>\<name>.uim.xml or <XS
server>\agora\glassfish\glassfish\domains\BTOA\config\uimashup\
import\languages\Pages\<lang>_<country_code>\<name>.uim.xml files relevant to
the language you want to install. These .uim.xml files represent the components and the
pages used in the Dashboard. lang is the language code and country_code is the code of
the country:

Language Language Code Country Code

Brazilian Portuguese pt BR

French fr FR

Spanish es ES

German de DE

Japanese ja JP
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Language Language Code Country Code

English en US

Dutch nl NL

Italian it IT

Simplified Chinese zh CN

Korean ko KR

Russian ru RU

b. Copy these .xml files to the
<XS_installation_
directory>\agora\glassfish\glassfish\domains\BTOA\config\uimashup\import\toload
folder.

Tip:

If the folder contains other sets of files (for different languages), it is recommended to
keep in the folder only the required set of language files and tomove the other files
outside the folder to prevent the loading of both set of language files and an unknown
result.

c. Import the out-of-the-box language files (only for the pages and components - events
are not localized) using the relevant procedure described in "Import or Export Out-of-the-
box Pages, Components, and Events" in theAdministrator Guide.

3. Test the installation
Check the universes in the Executive Scorecard Studio:

a. If you do not see them, run the Loadmeta data JMX.

b. If you still cannot see the universes, restart SAP BusinessObjects Enterprise and rerun the
“Loadmeta data” JMX. For details, see the IT Executive Scorecard Troubleshooting Guide.

4. Set up the User Interface Display Language
All translated files are provided with the product and the language of the user interface depends
on the language settings of your browser. English is the default language.

a. If you want to display the user interface in a non-English language, go to your browser
Tools > Internet Options.

b. In theGeneral tab, click Languages.

c. Add the language you want to view in the user interface and useMove up to move it to be
the first in the list.

d. Open a new browser and login to Executive Scorecard. The application is presented in the
chosen local language.

HP IT Executive Scorecard (9.30)Page 48 of 50

Upgrade Guide



5. Set up the Input and Content Language
The inputs and content language (i18N) depends on the definitions of your database. For
details on the supported languages, see IT Executive Scorecard Support Matrix.

Run the Post-Upgrade Script
1. Obtain thePOSTUPGRADESCRIPT.SQL script available in HP Software Support Online

web site (http://www.hp.com/go/hpsoftwaresupport) to fix a few additional data correctness-
related issues.

2. Run thePOSTUPGRADESCRIPT.SQL script in the Staging database.

Regenerate the Staging Target Data Store
Regenerate the Staging Target Data Store as follows:

1. Open CMD

2. Go to: <HPXS>\agora\DataWarehouse\bin

3. Execute the following commands:
n dw_ds_gen –outputdir c:\tmp\datastores\stagingtarget –datastore stagingtarget

n dw_ds_import -inputdir c:\tmp\datastores\stagingtarget

4. Open SAP BusinessObjects Data Services.
a. Click the DataStores Tab

b. Enter each one of the following DataStores if they exist:
o AMVIEW_DS

o PPMVIEW_DS

o SMVIEW_DS

c. Delete the tables in each Data Store.

d. You can now delete the Data Store.

5. In the application, click Admin > Data Source Management.
a. Edit the source connection details for all upgraded Content Packs and save.

b. Activate the relevant Content Packs.
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